## Contents

1. Copyright Notice................................................................................................................................. 5  
2. What is a barcode ?........................................................................................................................................ 7  
3. Getting Started with Dynamic Barcodes..................................................................................................... 8  
4. Using Dynamic Barcodes in Unlicensed Mode.......................................................................................... 10  
5. Dynamic Barcodes Basics.......................................................................................................................... 11  
   5.1 Creating a Barcode................................................................................................................................. 11  
   5.2 Editing a Barcode..................................................................................................................................... 14  
   5.3 Setting Barcode Parameters to Default.................................................................................................. 14  
   5.4 Barcode Placeholders............................................................................................................................. 15  
   5.4.1 Creating a Barcode Placeholder Quickly.......................................................................................... 15  
   5.4.2 Previewing and Creating a Barcode Placeholder................................................................................ 17  
6. Dynamic Barcodes Advanced.................................................................................................................... 20  
   6.1 Choosing a Font Standard....................................................................................................................... 20  
   6.2 Using Dynamic Content with Dynamic Barcodes.................................................................................. 20  
   6.3 Barcode Protection................................................................................................................................... 21  
   6.3.1 Protecting a Barcode.......................................................................................................................... 21  
   6.3.2 Handling a Barcode without Dynamic Barcodes................................................................................ 21  
   6.4 Exporting Documents with Barcodes..................................................................................................... 23  
   6.4.1 Viewing Barcode Information in Other Esko Applications.................................................................. 23  
   6.4.2 Editing Barcodes in Other Esko Applications................................................................................... 24  
7. Barcode Types and Parameters................................................................................................................... 25  
   7.1 Supported Barcode Types....................................................................................................................... 25  
   7.1.1 GS1 Application Identifiers................................................................................................................ 27  
   7.2 Barcode Types......................................................................................................................................... 32  
   7.2.1 2 of 5.................................................................................................................................................... 32  
   7.2.2 CLF-8.................................................................................................................................................... 33  
   7.2.3 Codabar................................................................................................................................................. 33  
   7.2.4 Code 128............................................................................................................................................. 34  
   7.2.5 Code 128 (long)................................................................................................................................. 35  
   7.2.6 Code 39................................................................................................................................................ 36  
   7.2.7 DataMatrix........................................................................................................................................... 37  
   7.2.8 EAN 8.................................................................................................................................................. 38  
   7.2.9 EAN 13................................................................................................................................................. 39  
   7.2.10 GS1 128............................................................................................................................................. 40  
   7.2.11 GS1 DataBar Omnidirectional........................................................................................................ 41  
   7.2.12 GS1 DataBar Stacked....................................................................................................................... 42
7.3 Barcode Parameters
7.3.1 Rotation
7.3.2 Code
7.3.3 Composite Component
7.3.4 Add Human Readable Characters
7.3.5 Put on Top
7.3.6 Multiple Text Lines
7.3.7 Light Margin Indicator
7.3.8 Font Family, Style and Size
7.3.9 Alignment
7.3.10 Vertical Offset
7.3.11 Use “992” Prod. Family in UPC
7.3.12 Max. Row Width
7.3.13 Text Format
7.3.14 Bar Width Reduction
7.2.40 UPC-SCS
7.2.39 UPC-E
7.2.38 UPC-A
7.2.37 SICK Code
7.2.36 MicroQR
7.2.35 QR
7.2.33 PZN
7.2.34 PZN8
7.2.35 QR
7.2.36 MicroQR
7.2.37 SICK Code
7.2.38 UPC-A
7.2.39 UPC-E
7.2.40 UPC-SCS
7.3.15 Device Compensation...........................................................................................................75
7.3.16 Magnification..........................................................................................................................75
7.3.17 Size........................................................................................................................................75
7.3.18 Height.....................................................................................................................................75
7.3.19 Characters per unit................................................................................................................76
7.3.20 Ratio......................................................................................................................................78
7.3.21 Narrow Bar...........................................................................................................................78
7.3.22 Wide Bar................................................................................................................................78
7.3.23 Gap........................................................................................................................................78
7.3.24 Vertical alignment..................................................................................................................78
7.3.25 Snap Bars to Output Resolution............................................................................................79
7.3.26 Decimal Input.......................................................................................................................79
7.3.27 Add Check Digit....................................................................................................................79
7.3.28 Symbol Type..........................................................................................................................80
7.3.29 Cell Size................................................................................................................................80
7.3.30 Width / Total Height..............................................................................................................80
7.3.31 Total Height..........................................................................................................................81
7.3.32 Smax / Smin............................................................................................................................81
7.3.33 Box.........................................................................................................................................82

8. Barcode Parameters from the Job Folder......................................................................................84
   8.1 Connecting to a Job Folder........................................................................................................84
   8.2 Connect Dynamic Barcodes to Job Setup................................................................................85
   8.3 Use Barcode parameters from Job Setup.................................................................................85
   8.4 Updating barcode parameters from Job Setup.........................................................................87
1. Copyright Notice

© Copyright 2016 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2015. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. **What is a barcode?**

A barcode is a machine-readable representation of information in a visual format on a surface. Barcodes can be read by optical scanners, allowing quick and easy identification of all kinds of goods.

Originally barcodes stored data in the widths and spacings of printed parallel lines, but today they also come in patterns of dots, concentric circles, and hidden in images.

The information contained in a barcode varies from numbers to complete ASCII texts. The drive to encode ever more information in combination with the space requirements of simple barcodes led to the development of matrix barcodes or 2D barcode, which do not consist of bars but rather a grid of square cells.

Barcodes are just the visible part of often quite large systems frequently referred to as automated identification systems. These systems are increasingly proving to be some of the most cost-effective management tools, since they enable organizations to keep track of their goods and stocks in all kinds of situations in a fast, accurate and efficient way.

With the Dynamic Barcodes plug-in, you can add a dynamic barcode to your document without leaving your application. Dynamic means that your barcode settings can be changed later on, even after you saved, closed and reopened your document.
3. Getting Started with Dynamic Barcodes

To introduce you to Dynamic Barcodes, here is how to make your first barcode in four simple steps.

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes. This opens the Dynamic Barcodes dialog.

2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.

3. Enter the barcode parameters (Barcode Type, numeric Code...) in the Dynamic Barcodes dialog.
   For example, for an EAN 13 barcode, select EAN 13 as Barcode Type and enter a 13 digit Code.
4. Click the **Create** button and Dynamic Barcodes will generate the barcode in your document.
4. Using Dynamic Barcodes in Unlicensed Mode

If you don't have a license for the Dynamic Barcodes plug-in, you still use it in unlicensed mode to perform limited operations. You can:

• Open documents containing barcodes created by Dynamic Barcodes without warning messages.

• Create barcode placeholders (with no data in them) in your design.
  See *Creating a Barcode Placeholder Quickly* on page 15.

You can also use the regular Illustrator functions to:

• change the barcode's position in your document,

• rotate it by multiples of 90 degrees (using Object > Transform > Rotate),

  **Tip:** You can rotate several barcodes at once.

• change its fill color (it is not possible to apply a stroke),

  **Attention:**

  Choose a fill color that is:
  
  • a process or a spot color (other colors might generate trapping problems),
  
  • not too light (or the barcode might be difficult to scan).

• copy and paste it.

• delete it.
5. Dynamic Barcodes Basics

5.1 Creating a Barcode

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes.
   You can also use the Command + Option + 4 shortcut on Mac, or the CTRL + Alt + 4 shortcut on PC.
   This opens the Dynamic Barcodes dialog.

2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.
   Dynamic Barcodes creates bars by generating rectangular objects and assigning the current fill style to them.
Attention:
Choose a fill color that is:
• a process or a spot color (other colors might generate trapping problems),
• not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
4. Enter a Rotation angle for your barcode, or use one of the rotation buttons. Choose the Orientation of your barcode using one of the buttons or by entering an angle.
5. Enter the barcode's data in the Code field. For most barcodes, you can choose to also show this data as a (human-readable) number.

Attention: Make sure the barcode data you enter is valid for the barcode type you chose. If it isn't, a warning / error will pop up.

Note: If you enter a wrong check digit, Dynamic Barcodes can fix it automatically for you.

6. To fill in other parameters specific to the barcode type you chose, open the Additional parameters section and see Barcode Types on page 32.
7. Click the **Create** button.
   - If you have the boostX plug-in installed, Dynamic Barcodes generates your barcode at the intersection of the boostX crosshair.
   - If you don’t have the boostX plug-in installed, Dynamic Barcodes generates your barcode in the center of the view.
5.2 Editing a Barcode

With Dynamic Barcodes, you can also edit existing barcodes.

1. Open the Dynamic Barcodes.
2. Select the barcode to edit in your Illustrator document.
3. Change its parameters as you wish in the Dynamic Barcodes dialog.

**Note:**
If you change the Barcode Type and the previous Code is not valid for this barcode type, Dynamic Barcodes will reset it to the (first) default code for this barcode type.

This is the default code used for placeholder barcodes; you can see it in the preset barcodes dialog (see Previewing and Creating a Barcode Placeholder on page 17).

You can then either:

- enter your own valid code,
- use this default code to create a placeholder barcode (see Creating a Barcode Placeholder Quickly on page 15).

4. Click the Apply button to apply your changes to the barcode.

5.3 Setting Barcode Parameters to Default

- To reset all the parameters of the selected barcode to default, click the palette menu in the top right corner of the Dynamic Barcodes dialog then click Set Default Parameters.
5.4 Barcode Placeholders

If you don't have the exact data to encode in your barcode yet, you can already create a barcode placeholder in your design.

This placeholder will have the correct symbol type for the barcode type you choose, but will only contain “empty” or “default” data (for example 0000000000000 for EAN 13).

5.4.1 Creating a Barcode Placeholder Quickly

1. Open the Dynamic Barcodes dialog from Windows > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.
3. In the Dynamic Barcodes dialog, select your Barcode Type.

   The Code field is automatically filled out with a null / default value that has the correct number of digits for your Barcode Type (for example 0000000000000 for EAN 13).

4. Click the Create button to create your barcode placeholder.
Note: You can also create a barcode placeholder in unlicensed mode (see Using Dynamic Barcodes in Unlicensed Mode on page 10).

5.4.2 Previewing and Creating a Barcode Placeholder

You can use Dynamic Barcodes to preview different barcode types before creating your barcode placeholder.

1. Open the Dynamic Barcodes dialog from Window > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no stroke.

   ![Color Palette](image)

   **Attention:**
   Choose a fill color that is:
   - a process or a spot color (other colors might generate trapping problems),
   - not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, click the Pre-set barcodes icon.
   This opens the Select Barcode dialog.
4. Select your **Barcode Type** on the right to see a **Preview** of it on the left.

**Note:** This shows previews of barcode placeholders. Your actual barcode (with data and specific parameters affecting its size) may look slightly different. For more information on barcode parameters, see *Barcode Types* on page 32.

5. If your barcode data can have several possible lengths (for example EAN 13 can have 13, 15 or 18 digits), choose the length you want to preview in **Code Preset**.

6. If your barcode can have a **Composite Component** (some GS1 barcodes), you can choose to preview it with or without that component.

7. Click **OK** to use the preview parameters (**Barcode Type**, **Code Preset** and **Composite Component** as applicable) in the **Dynamic Barcodes** dialog and close the **Select Barcode** dialog.

8. In the **Dynamic Barcodes** dialog, click the **Create** button to create your barcode placeholder.
Dynamic Barcodes for Adobe Illustrator
6. Dynamic Barcodes Advanced

6.1 Choosing a Font Standard

You can choose between two font standards for the human-readable characters of your barcodes.

1. Go to Illustrator > Preferences > Esko > Dynamic Barcodes Preferences... to open the Dynamic Barcodes Preferences dialog.

2. Choose either OCR-B Standard or OCR-B Bitstream and click OK.

| OCR-B Standard fonts are rounder and typically used in the Western market. | 1 2345678 |
|OCR-B Bitstream fonts are typically used in the Asian market. | 1 234567 |

Note: If the OCR-B Bitstream font is not installed on your system, the option will be disabled. Esko does not provide this font.

6.2 Using Dynamic Content with Dynamic Barcodes

You can use the Dynamic Content plug-in to turn barcodes created with Dynamic Barcodes into XML-driven objects. These barcodes update automatically when the XML files to which they are linked change.
6.3 Barcode Protection

Once you create a barcode with Dynamic Barcodes, this barcode is protected. This means that it won't be possible to edit it with most regular Illustrator tools. This protects the barcode against modifications that might render it invalid, for example distorting it or modifying its size. You can still edit the barcode's parameters at any time through the Dynamic Barcodes dialog.

6.3.1 Protecting a Barcode

You can protect a Dynamic Barcodes barcode that has been unprotected, or a barcode made in a previous version of Dynamic Barcodes.

1. Open the Dynamic Barcodes plug-in.
2. Select the barcode to protect in your Illustrator document.
3. If necessary, change its parameters in the Dynamic Barcodes dialog.
4. Click the Apply button to apply the parameter changes and protect your barcode.

**Tip:** You can use this to fix some invalid barcodes.

6.3.2 Handling a Barcode without Dynamic Barcodes

Opening a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes

When opening a document containing a Dynamic Barcodes barcode in an Illustrator application that doesn't have the Dynamic Barcodes plug-in, you will get the following warning:
This **doesn't create any problem in your file**, and you can continue to work with this file as you normally would, without editing the Dynamic Barcodes barcode.

If you need to edit the Dynamic Barcodes barcode with your Illustrator application, see *Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes* on page 22.

**Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes**

If you don't have the Dynamic Barcodes plug-in, you can still use Illustrator to do the following operations without rendering your barcode invalid.

If you don't have Dynamic Barcodes installed, you will **not** be able to
- move or scale the object using the Selection tool
- move or distort it (reflect, shear or scale)
- change a color

You will be able to
- expand the bar code
- Rotate by Selection or Free transform - this can lead to inconsistent results so we recommend not doing this.
- move, rotate and distort by the Transform Each command - this can lead to inconsistent results so we recommend not doing this.
- enclose it in the Envelope and distort
- delete it
- copy and paste it

If the Dynamic Barcode plugin is installed, but without a valid license, you will be able to do everything that is allowed by the plugin, except modifying the content. This means for example moving and rotating is allowed, but due to the bar code protection, any potentially dangerous operations such as scale, reflect or shear are not allowed. You will also be able to change the color of the bar code.

**Unprotecting a Dynamic Barcodes Barcode for Further Editing**

You can expand your Dynamic Barcodes barcode to a regular Illustrator group art to be able to edit it further, but this is not recommended as it will **remove the barcode's protection**.

---

<table>
<thead>
<tr>
<th><strong>Attention:</strong></th>
<th>It will then be possible to make modifications that <strong>might render the barcode invalid</strong>.</th>
</tr>
</thead>
</table>

1. To do this, go to **Object > Expand...** in the Illustrator menu.
2. Choose the object's characteristics to expand, then click **OK**.
This turns your barcode into a regular Illustrator object. You can now for example edit each bar of the barcode individually.

6.4 Exporting Documents with Barcodes

If you are using other Esko applications, you can export Illustrator documents containing barcodes to the Esko Normalized PDF format, preserving the barcodes’ information and editability.

6.4.1 Viewing Barcode Information in Other Esko Applications

1. Export your Illustrator document to the Esko Normalized PDF format:
   • If you have Automation Engine, use Shuttle to launch the document into your chosen workflow. This converts it to Normalized PDF automatically.
     
     **Note:** See the Adobe Illustrator Client documentation for setup information.

   • If you don’t have Automation Engine, use File > Export and choose Normalized PDF as the export format.

2. Select (in Automation Engine) or open (in PackEdge / Acrobat) your document and open the XMP information as explained below:

<table>
<thead>
<tr>
<th>If you have...</th>
<th>go to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Engine</td>
<td>File &gt; Info</td>
</tr>
<tr>
<td>PackEdge</td>
<td>File &gt; XMP Info</td>
</tr>
<tr>
<td>the Esko XMP plug-in</td>
<td>Esko &gt; XMP Document Info...</td>
</tr>
<tr>
<td>in Adobe Acrobat</td>
<td></td>
</tr>
</tbody>
</table>

3. Click Barcodes in the Data type column (as below in PackEdge) to show the barcode information.
6.4.2 Editing Barcodes in Other Esko Applications

The Dynamic Barcodes functionality is available both as a DeskPack plug-in and in PackEdge.

- To edit your document containing barcodes in PackEdge:
  a) Export your Illustrator document to the Esko Normalized PDF format:
     • If you have Automation Engine, use Shuttle to launch the document into your chosen workflow. This converts it to Normalized PDF automatically.

     Note: See the Adobe Illustrator Client documentation for setup information.

     • If you don't have Automation Engine, use File > Export and choose Normalized PDF as the export format.
  b) Open your document in PackEdge.
  c) Go to Production > Bar Code... to edit your barcode as you would edit it with Dynamic Barcodes.

For more information, see the Shuttle and PackEdge documentation.
7. Barcode Types and Parameters

7.1 Supported Barcode Types

<table>
<thead>
<tr>
<th>General Purpose Barcodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1D</strong></td>
</tr>
<tr>
<td>• Code 39</td>
</tr>
<tr>
<td>• 2 of 5</td>
</tr>
<tr>
<td>• Interleaved 2 of 5</td>
</tr>
<tr>
<td>• Codabar</td>
</tr>
<tr>
<td>• Code 128</td>
</tr>
<tr>
<td>• Code 128 (long)</td>
</tr>
<tr>
<td>• MSI</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Retail Barcodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1D</strong></td>
</tr>
<tr>
<td>• EAN 13</td>
</tr>
<tr>
<td>• EAN 8</td>
</tr>
<tr>
<td>• UPC-A</td>
</tr>
<tr>
<td>• UPC-E</td>
</tr>
<tr>
<td>• GS1 DataBar Omnidirectional</td>
</tr>
<tr>
<td>• GS1 DataBar Truncated</td>
</tr>
<tr>
<td>• GS1 DataBar Stacked</td>
</tr>
<tr>
<td>• GS1 DataBar Stacked Omnidirectional</td>
</tr>
<tr>
<td>• GS1 DataBar Limited</td>
</tr>
<tr>
<td>• GS1 DataBar Expanded</td>
</tr>
<tr>
<td>• GS1 DataBar Expanded Stacked</td>
</tr>
</tbody>
</table>
### Pharmaceutical, Healthcare and Cosmetic Barcodes

**1D**
- NDC / HRI
- Laetus Pharma Code
- CLF-8
- HIBC 39
- HIBC 128
- Paraf Italy
- PZN
- PZN8

### Shipment Container Barcodes

**1D**
- ITF-14
- ITF-16
- UPC-SCS

### Identity Document Barcode

**2D**
- PDF417
7.1.1 GS1 Application Identifiers

These are the GS1 Application Identifiers available in Dynamic Barcodes:

<table>
<thead>
<tr>
<th></th>
<th>Data Content</th>
<th>Format (*)</th>
<th>FNC1 Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Serial Shipping Container Code (SSCC)</td>
<td>N2+N18</td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>Global Trade Item Number (GTIN)</td>
<td>N2+N14</td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>GTIN of Contained Trade Items</td>
<td>N2+N14</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Batch or Lot Number</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>11 (**)</td>
<td>Production Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>12 (**)</td>
<td>Due Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>13 (**)</td>
<td>Packaging Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>15 (**)</td>
<td>Best Before Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>16 (**)</td>
<td>Sell By Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>17 (**)</td>
<td>Expiration Date (YYMMDD)</td>
<td>N2+N6</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Variant Number</td>
<td>N2+N2</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Serial Number</td>
<td>N2+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>240</td>
<td>Additional Item Identification</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>241</td>
<td>Customer Part Number</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>242</td>
<td>Made-to-Order Variation Number</td>
<td>N3+N..6</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>243</td>
<td>Packaging Component Number</td>
<td>N3+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>250</td>
<td>Secondary Serial Number</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>251</td>
<td>Reference to Source Entity</td>
<td>N3+X..30</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>253</td>
<td>Global Document Type Identifier (GDTI)</td>
<td>N3+N13+X..17</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>254</td>
<td>GLN Extension Component</td>
<td>N3+X..20</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>255</td>
<td>Global Coupon Number (GCN)</td>
<td>N3+N13+N..12</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>30</td>
<td>Count of Items (Variable Measure Trade Item)</td>
<td>N2+N..8</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>310 (***)</td>
<td>Net weight, kilograms (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>311 (***)</td>
<td>Length or first dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>312 (***)</td>
<td>Width, diameter, or second dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>313 (***)</td>
<td>Depth, thickness, height, or third dimension, metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>314 (***)</td>
<td>Area, square metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>315 (***)</td>
<td>Net volume, litres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Measure Type</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>316</td>
<td>Net volume, cubic metres (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>320</td>
<td>Net weight, pounds (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>321</td>
<td>Length or first dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>322</td>
<td>Length or first dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>323</td>
<td>Length or first dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>324</td>
<td>Width, diameter, or second dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>325</td>
<td>Width, diameter, or second dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>326</td>
<td>Width, diameter, or second dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>327</td>
<td>Depth, thickness, height, or third dimension, inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>328</td>
<td>Depth, thickness, height, or third dimension, feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>329</td>
<td>Depth, thickness, height, or third dimension, yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>330</td>
<td>Logistic weight, kilograms</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>331</td>
<td>Length or first dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>332</td>
<td>Width, diameter, or second dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>333</td>
<td>Depth, thickness, height, or third dimension, metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>334</td>
<td>Area, square metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>335</td>
<td>Logistic volume, litres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>336</td>
<td>Logistic volume, cubic metres</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>337</td>
<td>Kilograms per square metre</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Logistic weight, pounds</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>341</td>
<td>Length or first dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>342</td>
<td>Length or first dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>343</td>
<td>Length or first dimension, yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>344</td>
<td>Width, diameter, or second dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>345</td>
<td>Width, diameter, or second dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>346</td>
<td>Width, diameter, or second dimension, yard</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>347</td>
<td>Depth, thickness, height, or third dimension, inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Format</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>348</td>
<td>Depth, thickness, height, or third dimension, feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>349</td>
<td>Depth, thickness, height, or third dimension, yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>350</td>
<td>Area, square inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>351</td>
<td>Area, square feet (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>352</td>
<td>Area, square yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>353</td>
<td>Area, square inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>354</td>
<td>Area, square feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>355</td>
<td>Area, square yards</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>356</td>
<td>Net weight, troy ounces (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>357</td>
<td>Net weight (or volume), ounces (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>358</td>
<td>Net volume, quarts (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>359</td>
<td>Net volume, gallons U.S. (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>360</td>
<td>Logistic volume, quarts</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>361</td>
<td>Logistic volume, gallons U.S.</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>362</td>
<td>Net volume, cubic inches (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>363</td>
<td>Net volume, cubic feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>364</td>
<td>Net volume, cubic yards (Variable Measure Trade Item)</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>365</td>
<td>Logistic volume, cubic inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>366</td>
<td>Logistic volume, cubic feet</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>367</td>
<td>Logistic volume, cubic inches</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>368</td>
<td>Count of Trade Items</td>
<td>N2+N..8 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Applicable Amount Payable or Coupon Value, local currency</td>
<td>N4+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>390</td>
<td>Applicable Amount Payable with ISO Currency Code</td>
<td>N4+N3+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>391</td>
<td>Applicable Amount Payable, single monetary area (Variable Measure Trade Item)</td>
<td>N4+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>392</td>
<td>Applicable Amount Payable with ISO Currency Code (Variable Measure Trade Item)</td>
<td>N4+N3+N..15 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Customer's Purchase Order Number</td>
<td>N3+X..30 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>401</td>
<td>Global Identification Number for Consignment (GINC)</td>
<td>N3+X..30 (FNC1)</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Format</td>
<td>(FNC1)</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>402</td>
<td>Global Shipment Identification Number (GSIN)</td>
<td>N3+N17</td>
<td></td>
</tr>
<tr>
<td>403</td>
<td>Routing Code</td>
<td>N3+X..30</td>
<td></td>
</tr>
<tr>
<td>410</td>
<td>Ship to - Deliver to Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>411</td>
<td>Bill to - Invoice to Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>412</td>
<td>Purchased from Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>413</td>
<td>Ship for - Deliver for - Forward to Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>414</td>
<td>Identification of a Physical Location - Global Location Number</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>415</td>
<td>Global Location Number of the Invoicing Party</td>
<td>N3+N13</td>
<td></td>
</tr>
<tr>
<td>420</td>
<td>Ship to - Deliver to Postal Code Within a Single Postal Authority</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>421</td>
<td>Ship to - Deliver to Postal Code with ISO Country Code</td>
<td>N3+N3+X..9</td>
<td></td>
</tr>
<tr>
<td>422</td>
<td>Country of Origin of a Trade Item</td>
<td>N3+N3</td>
<td></td>
</tr>
<tr>
<td>423</td>
<td>Country of Initial Processing</td>
<td>N3+N3+N..12</td>
<td></td>
</tr>
<tr>
<td>424</td>
<td>Country of Processing</td>
<td>N3+N3</td>
<td></td>
</tr>
<tr>
<td>425</td>
<td>Country of Disassembly</td>
<td>N3+N3</td>
<td></td>
</tr>
<tr>
<td>426</td>
<td>Country Covering full Process Chain</td>
<td>N3+N3</td>
<td></td>
</tr>
<tr>
<td>427</td>
<td>Country Subdivision of Origin</td>
<td>N3+N3+N..12</td>
<td></td>
</tr>
<tr>
<td>7001</td>
<td>NATO Stock Number (NSN)</td>
<td>N4+N13</td>
<td></td>
</tr>
<tr>
<td>7002</td>
<td>UN/ECE Meat Carcasses and Cuts Classification</td>
<td>N4+X..30</td>
<td></td>
</tr>
<tr>
<td>7003</td>
<td>Expiration Date and Time</td>
<td>N4+N10</td>
<td></td>
</tr>
<tr>
<td>7004</td>
<td>Active Potency</td>
<td>N4+N..4</td>
<td></td>
</tr>
<tr>
<td>7005</td>
<td>Catch Area</td>
<td>N4+X..12</td>
<td></td>
</tr>
<tr>
<td>7006</td>
<td>First Freeze Date</td>
<td>N4+N6</td>
<td></td>
</tr>
<tr>
<td>7007</td>
<td>Harvest Date</td>
<td>N4+N6..12</td>
<td></td>
</tr>
<tr>
<td>7008</td>
<td>Species for Fishery Purposes</td>
<td>N4+X..3</td>
<td></td>
</tr>
<tr>
<td>7009</td>
<td>Fishing Gear Type</td>
<td>N4+N..10</td>
<td></td>
</tr>
<tr>
<td>7010</td>
<td>Production Method</td>
<td>N4+X..2</td>
<td></td>
</tr>
<tr>
<td>703s</td>
<td>Number of Processor with ISO Country Code</td>
<td>N4+N3+X..27</td>
<td></td>
</tr>
<tr>
<td>710</td>
<td>National Healthcare Reimbursement Number (NHRN) – Germany PZN</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>711</td>
<td>National Healthcare Reimbursement Number (NHRN) – France CIP</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>712</td>
<td>National Healthcare Reimbursement Number (NHRN) – Spain CN</td>
<td>N3+X..20</td>
<td></td>
</tr>
<tr>
<td>713</td>
<td>National Healthcare Reimbursement Number (NHRN) – Brasil DRN</td>
<td>N3+X..20</td>
<td></td>
</tr>
</tbody>
</table>
Dynamic Barcodes for Adobe Illustrator

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Format</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>8001</td>
<td>Roll Products (Width, Length, Core Diameter, Direction, Splices)</td>
<td>N4+N14</td>
<td></td>
</tr>
<tr>
<td>8002</td>
<td>Cellular Mobile Telephone Identifier</td>
<td>N4+X..20</td>
<td>FNC1</td>
</tr>
<tr>
<td>8003</td>
<td>Global Returnable Asset Identifier (GRAI)</td>
<td>N4+N14+X..16</td>
<td>FNC1</td>
</tr>
<tr>
<td>8004</td>
<td>Global Individual Asset Identifier (GIAI)</td>
<td>N4+X..30</td>
<td>FNC1</td>
</tr>
<tr>
<td>8005</td>
<td>Price Per Unit of Measure</td>
<td>N4+N6</td>
<td>FNC1</td>
</tr>
<tr>
<td>8006</td>
<td>Identification of the Components of a Trade Item</td>
<td>N4+N14+N2+N2</td>
<td>FNC1</td>
</tr>
<tr>
<td>8007</td>
<td>International Bank Account Number (IBAN)</td>
<td>N4+X..34</td>
<td>FNC1</td>
</tr>
<tr>
<td>8008</td>
<td>Date and Time of Production</td>
<td>N4+N8+N..4</td>
<td>FNC1</td>
</tr>
<tr>
<td>8010</td>
<td>Component / Part Identifier (CPID)</td>
<td>N4 + X..30</td>
<td>FNC1</td>
</tr>
<tr>
<td>8011</td>
<td>Component / Part Identifier Serial Number (CPID SERIAL)</td>
<td>N4 + N..12</td>
<td>FNC1</td>
</tr>
<tr>
<td>8017</td>
<td>Global Service Relation Number to identify the relationship between an organisation offering services and the provider of services</td>
<td>N4+N18</td>
<td>FNC1</td>
</tr>
<tr>
<td>8018</td>
<td>Global Service Relation Number to identify the relationship between an organisation offering services and the recipient of services</td>
<td>N4+N18</td>
<td>FNC1</td>
</tr>
<tr>
<td>8019</td>
<td>Service Relation Instance Number (SRIN)</td>
<td>N4+N..10</td>
<td>FNC1</td>
</tr>
<tr>
<td>8020</td>
<td>Payment Slip Reference Number</td>
<td>N4+X..25</td>
<td>FNC1</td>
</tr>
<tr>
<td>8100</td>
<td>GS1-128 Coupon Extended Code</td>
<td>N4+N6</td>
<td>FNC1</td>
</tr>
<tr>
<td>8101</td>
<td>GS1-128 Coupon Extended Code</td>
<td>N4+N1+N5+N4</td>
<td>FNC1</td>
</tr>
<tr>
<td>8102</td>
<td>GS1-128 Coupon Extended Code</td>
<td>N4+N1+N1</td>
<td>FNC1</td>
</tr>
<tr>
<td>8110</td>
<td>Coupon Code Identification for Use in North America</td>
<td>N4+X..70</td>
<td>FNC1</td>
</tr>
<tr>
<td>8200</td>
<td>Extended Packaging URL</td>
<td>N4+X..70</td>
<td>FNC1</td>
</tr>
<tr>
<td>90</td>
<td>Information Mutually Agreed Between Trading Partners</td>
<td>N2+X..30</td>
<td>FNC1</td>
</tr>
<tr>
<td>91 to 99</td>
<td>Company Internal Information</td>
<td>N2+X..30</td>
<td>FNC1</td>
</tr>
</tbody>
</table>

Notes

- ***: The first position indicates the length (number of digits) of the GS1 Application Identifier. The following value refers to the format of the data content. The following convention is applied:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>numeric digit</td>
</tr>
<tr>
<td>X</td>
<td>any character</td>
</tr>
<tr>
<td>N3</td>
<td>3 numeric digits, fixed length</td>
</tr>
<tr>
<td>N..3</td>
<td>up to 3 numeric digits</td>
</tr>
<tr>
<td>X..3</td>
<td>up to 3 characters</td>
</tr>
</tbody>
</table>

- ****: If only year and month are available, DD must be filled with two zeroes.
- ***: The fourth digit of this GS1 Application Identifier indicates the implied decimal point position. Example:
• 3100 Net weight in kg without a decimal point
• 3102 Net weight in kg with two decimal points
• FNC1: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1 QR Code Symbology.

7.2 Barcodes Types

To create a barcode of a specific type, select it in the Barcode Type parameter. This displays parameters specific to this barcode type in the Dynamic Barcodes dialog.

7.2.1 2 of 5

About this Barcode...
2 of 5 is a numeric self-checking barcode, which can have a variable length. This barcode only encodes data in the bars. It is used for industrial applications, article numbering, photo development and ticketing.

Parameters
General Parameters
• Rotation on page 70
• Code on page 70

Text Parameters
• Add Human Readable Characters on page 71
• Font Family, Style and Size on page 73
• Alignment on page 73
• Vertical Offset on page 73

Additional Parameters
• Bar Width Reduction on page 74
• Device Compensation on page 75
• Height on page 75
• Characters per unit on page 76
• Ratio on page 78
• Narrow Bar on page 78
7.2.2 CLF-8

About this Barcode...
The CLF-8 barcode is part of the same barcode family as the Laetus Pharma Code. It is used in the pharmaceutical industry.

Parameters

General Parameters

- Rotation on page 70
- Code on page 70

Text Parameters

- Add Human Readable Characters on page 71
- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73

Additional Parameters

- Bar Width Reduction on page 74
- Device Compensation on page 75
- Height on page 75
- Ratio on page 78
- Narrow Bar on page 78
- Wide Bar on page 78
- Gap on page 78
- Snap Bars to Output Resolution on page 79

7.2.3 Codabar

About this Barcode...
The Codabar barcode is commonly used in libraries, blood banks, and the air parcel business. It can encode up to 126 characters of data and two control characters, using digits and the ".", "+", ":", "/" and "+" characters.
Parameters

General Parameters
- Rotation on page 70
- Code on page 70

Text Parameters
- Add Human Readable Characters on page 71
- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73

Additional Parameters
- Rational (Constant Bar Width): By enabling this option, you can create a "Rational" Codabar bar code.
- Use “992“ Prod. Family in UPC on page 74
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Height on page 75
- Characters per unit on page 76
- Ratio on page 78
- Narrow Bar on page 78
- Snap Bars to Output Resolution on page 79
- Box on page 82

7.2.4 Code 128

About this Barcode...

Code 128 is a variable length, high density, alphanumeric barcode. It has the second highest density of all the 1D barcodes (after the GS1 Databar Expanded).

It can contain a set of control characters. These control characters can change the character encoding type. In the absence of control characters, the encoding type is chosen automatically, to optimize the content encoding.
To force the usage of the code-set A, precede your data with the \[a\] control character. To force the usage of the code-set B, precede your data with the \[b\] control character. To obtain an optimal utilization of the code-sets A and B but prevent the usage of the space saving code-set C, use the Code 128 (long) barcode type instead.

### Parameters

**General Parameters**
- Rotation on page 70
- Code on page 70

**Text Parameters**
- Add Human Readable Characters on page 71
- Light Margin Indicator on page 72
- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73

**Additional Parameters**
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Height on page 75
- Characters per unit on page 76
- Narrow Bar on page 78
- Snap Bars to Output Resolution on page 79
- Box on page 82

### 7.2.5 Code 128 (long)

**About this Barcode...**
Code 128 (long) is a version of Code 128 that doesn't use the space-saving “C” character set. This makes Code 128 (long) barcodes generally longer.
Parameters

General Parameters

• Rotation on page 70
• Code on page 70

Text Parameters

• Add Human Readable Characters on page 71
• Light Margin Indicator on page 72
• Font Family, Style and Size on page 73
• Alignment on page 73
• Vertical Offset on page 73

Additional Parameters

• Bar Width Reduction on page 74
• Device Compensation on page 75
• Height on page 75
• Characters per unit on page 76
• Narrow Bar on page 78
• Snap Bars to Output Resolution on page 79
• Box on page 82

7.2.6 Code 39

About this Barcode...
Code 39 is a popular barcode in industrial barcoding systems, mainly in the U.S.A. It is used in the non-retail industry, particularly in the manufacturing, military, and health sectors. It can encode alphanumeric data.
• **Add Human Readable Characters** on page 71
• **Font Family, Style and Size** on page 73
• **Alignment** on page 73
• **Vertical Offset** on page 73

**Additional Parameters**
• **Bar Width Reduction** on page 74
• **Device Compensation** on page 75
• **Height** on page 75
• **Characters per unit** on page 76
• **Ratio** on page 78
• **Narrow Bar** on page 78
• **Snap Bars to Output Resolution** on page 79
• **Add Check Digit** on page 79
• **Box** on page 82

7.2.7 **DataMatrix**

**About this Barcode...**
DataMatrix is used for encoding large amounts of alphanumeric data and / or marking small objects. It can encode all the standard ASCII and extended ASCII characters.

The DataMatrix symbol size can adjust automatically depending on the amount of data.

Dynamic Barcodes doesn't generate human readable characters for DataMatrix symbols. The data to be encoded in a DataMatrix symbol can contain an FNC1 character but only at the beginning of the data.

**Note:** Dynamic Barcodes always generates DataMatrix symbols with the recommended ECC200 error correction scheme.

---

**Parameters**
**DATAMatrix**

**General Parameters**
• **Rotation** on page 70
Dynamic Barcodes for Adobe Illustrator

- **Code** on page 70

**Additional Parameters**
- **Bar Width Reduction** on page 74
- **Device Compensation** on page 75
- **Symbol Type** on page 80
- **Cell Size** on page 80
- **Width / Total Height** on page 80
- **Box** on page 82

### 7.2.8 EAN 8

**About this Barcode...**

EAN 8 is an abbreviated version of EAN 13, for use on smaller packages. It contains eight digits of data.

---

**Parameters**

**General Parameters**
- **Rotation** on page 70
- **Code** on page 70

**Text Parameters**
- **Add Human Readable Characters** on page 71
- **Light Margin Indicator** on page 72
- **Font Family, Style and Size** on page 73
- **Vertical Offset** on page 73

**Additional Parameters**
- **Bar Width Reduction** on page 74
- **Device Compensation** on page 75
- **Magnification** on page 75
7.2.9 EAN 13

About this Barcode...

European Article Numbering system or EAN is the standard for article numbering in Europe. It is also used in Japan where it is called JAN.

**Note:** EAN is the European equivalent of the UPC system in the U.S.A. and Canada. Both systems use the same size requirements and a similar encoding scheme. This means that most European and American retail barcode scanners can read both EAN and UPC barcodes. For more information on UPC, see *UPC-A* on page 67.

An EAN 13 is a numeric barcode of thirteen digits, and can have two or five additional digits.

Parameters

**General Parameters**

- *Rotation* on page 70
- *Code* on page 70

**Text Parameters**

- *Add Human Readable Characters* on page 71
- *Light Margin Indicator* on page 72
- *Font Family, Style and Size* on page 73
- *Vertical Offset* on page 73
Additional Parameters

- *Bar Width Reduction* on page 74
- *Device Compensation* on page 75
- *Magnification* on page 75
- *Height* on page 75
- *Snap Bars to Output Resolution* on page 79
- *Box* on page 82

7.2.10 GS1 128

**About this Barcode...**

GS1 128 (formerly EAN 128) is a Code 128 barcode designed primarily to identify products. It contains one or more FNC1 (GS1 Function Code 1) control characters and Application Identifiers. It shows parentheses around the human readable interpretation of the Application Identifiers, but those parentheses are not encoded in the barcode.

It is alphanumeric and can also contain composite symbols.

**Parameters**

**General Parameters**

- *Rotation* on page 70
- *Code* on page 70
- *Composite Component* on page 71

**Text Parameters**
• Add Human Readable Characters on page 71
• Put on Top on page 72
• Multiple Text Lines on page 72
• Font Family, Style and Size on page 73
• Alignment on page 73
• Vertical Offset on page 73

Additional Parameters
• Bar Width Reduction on page 74
• Device Compensation on page 75
• Magnification on page 75
• Height on page 75
• Narrow Bar on page 78
• Snap Bars to Output Resolution on page 79
• Box on page 82

7.2.11 GS1 DataBar Omnidirectional

About this Barcode...
The barcodes of the GS1 DataBar family (formerly Reduced Space Symbols or RSS) can identify small items, and encode more information than the current EAN or UPC barcodes. They can include GS1 Application Identifiers such as serial numbers, lot numbers, expiration dates...

Note: GS1 DataBar codes are expected to replace most common EAN and UPC barcodes from 2010.

GS1 DataBar Omnidirectional encodes Global Trade Item Numbers (GTIN) in a linear symbol that can be scanned omnidirectionally by suitably programmed slot scanners.
Dynamic Barcodes for Adobe Illustrator

- **Rotation** on page 70
- **Code** on page 70
- **Composite Component** on page 71

**Text Parameters**
- **Add Human Readable Characters** on page 71
- **Put on Top** on page 72
- **Multiple Text Lines** on page 72
- **Font Family, Style and Size** on page 73
- **Alignment** on page 73
- **Vertical Offset** on page 73

**Additional Parameters**
- **Bar Width Reduction** on page 74
- **Device Compensation** on page 75
- **Narrow Bar** on page 78
- **Snap Bars to Output Resolution** on page 79

### 7.2.12 GS1 DataBar Stacked

**About this Barcode...**
GS1 DataBar Stacked is a variation of the GS1 DataBar barcode, that is stacked in two rows and used when the normal barcode would be too wide for the product.

![GS1 DataBar Stacked Example](image)

**Parameters**

**General Parameters**
- **Rotation** on page 70
- **Code** on page 70
- **Composite Component** on page 71

**Text Parameters**
- **Add Human Readable Characters** on page 71
- **Multiple Text Lines** on page 72
Dynamic Barcodes for Adobe Illustrator

- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73

Additional Parameters
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Narrow Bar on page 78
- Snap Bars to Output Resolution on page 79

7.2.13 GS1 DataBar Stacked Omnidirectional

About this Barcode...

GS1 DataBar14 Stacked Omnidirectional is taller version of GS1 DataBar14 Stacked, that can be read by omnidirectional scanners.

Parameters

General Parameters
- Rotation on page 70
- Code on page 70
- Composite Component on page 71

Text Parameters
- Add Human Readable Characters on page 71
- Put on Top on page 72
- Multiple Text Lines on page 72
- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73
Dynamic Barcodes for Adobe Illustrator

**Additional Parameters**
- *Bar Width Reduction* on page 74
- *Device Compensation* on page 75
- *Narrow Bar* on page 78
- *Snap Bars to Output Resolution* on page 79

### 7.2.14 GS1 DataBar Truncated

**About this Barcode...**
GS1 DataBar Truncated (formerly RSS Limited) is similar to GS1 DataBar but the height of its bars is truncated.

It encodes Global Trade Item Numbers in a smaller symbol for use on small items. It cannot be scanned omnidirectionally.

#### Parameters

**General Parameters**
- *Rotation* on page 70
- *Code* on page 70
- *Composite Component* on page 71

**Text Parameters**
- *Add Human Readable Characters* on page 71
- *Put on Top* on page 72
- *Multiple Text Lines* on page 72
- *Font Family, Style and Size* on page 73
- *Alignment* on page 73
- *Vertical Offset* on page 73

**Additional Parameters**
- *Bar Width Reduction* on page 74
- *Device Compensation* on page 75
- *Narrow Bar* on page 78
Dynamic Barcodes for Adobe Illustrator

• Snap Bars to Output Resolution on page 79

7.2.15 GS1 DataBar Expanded

About this Barcode...
GS1 DataBar Expanded (formerly RSS Expanded) encodes regular barcode data ("primary item identification" data) and Application Identifiers. It can encode alphanumeric characters. This barcode can be scanned omnidirectionally by suitably programmed slot scanners.

Parameters

General Parameters
• Rotation on page 70
• Code on page 70
• Composite Component on page 71

Text Parameters
• Add Human Readable Characters on page 71
• Put on Top on page 72
• Multiple Text Lines on page 72
• Font Family, Style and Size on page 73
• Alignment on page 73
• Vertical Offset on page 73

Additional Parameters
• Bar Width Reduction on page 74
• Device Compensation on page 75
• Narrow Bar on page 78
• Snap Bars to Output Resolution on page 79

7.2.16 GS1 DataBar Expanded Stacked

About this Barcode...
GS1 DataBar Expanded Stacked can encode the same amount of data as GS1 DataBar Expanded, but can also “stack” the barcode into several rows to save space.
Parameters

General Parameters

- Rotation on page 70
- Code on page 70
- Composite Component on page 71

Text Parameters

- Add Human Readable Characters on page 71
- Put on Top on page 72
- Multiple Text Lines on page 72
- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73

Additional Parameters

- Max. Row Width on page 74
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Narrow Bar on page 78
- Snap Bars to Output Resolution on page 79

7.2.17 GS1 DataBar Limited

About this Barcode...

GS1 Databar Limited is smaller than the GS1 DataBar barcode and can only encode Global Trade Item Numbers whose data part starts with “1”.
Parameters

General Parameters
- Rotation on page 70
- Code on page 70
- Composite Component on page 71

Text Parameters
- Add Human Readable Characters on page 71
- Put on Top on page 72
- Multiple Text Lines on page 72
- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73

Additional Parameters
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Narrow Bar on page 78
- Snap Bars to Output Resolution on page 79

7.2.18 GS1 DataMatrix

About this Barcode...
The GS1 Data Matrix barcode is a high density, high capacity, scalable 2D barcode. It is used to concentrate a lot of (alphanumeric) information in a very small space.

Parameters

General Parameters
- Rotation on page 70
- Code on page 70
7.2.19 GS1 U.S. Coupon Interim

About this Barcode...

GS1 U.S. Coupon Interim is an interim coupon barcode. It is used during the transition between UPC-A coupons and the new GS1 Databar Expanded Stacked coupons, that can encode more information.

It is made of both an old UPC-A coupon barcode, and a new Databar Expanded Stacked coupon barcode, to be readable by both old and new scanners.

Parameters

General Parameters

• Rotation on page 70
• Code on page 70

Text Parameters
• Add Human Readable Characters on page 71
• Font Family, Style and Size on page 73

Additional Parameters
• Use “992” Prod. Family in UPC on page 74
• Max. Row Width on page 74
• Bar Width Reduction on page 74
• Device Compensation on page 75
• Magnification on page 75
• Narrow Bar on page 78
• Gap on page 78
• Vertical alignment on page 78
• Snap Bars to Output Resolution on page 79

7.2.20 HIBC 128

About this Barcode...
This barcode is based on the Code 128 symbology.
It encodes the organization's primary and/or secondary Labeler Identification Code (LIC). This encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are encoded in one barcode, they are divided by the “/” character.
7.2.21 HIBC 39

About this Barcode...
This barcode is based on the Code 39 symbology. It encodes the organization's primary and/or secondary Labeler Identification Code (LIC). This encoding begins with the "+" character. If both primary and secondary Labeler Identification Codes are encoded in one barcode, they are divided by the "/" character.

Parameters

General Parameters
- Rotation on page 70
- Code on page 70

Text Parameters
- Add Human Readable Characters on page 71
- Font Family, Style and Size on page 73
- Vertical Offset on page 73

Additional Parameters
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Magnification on page 75
- Height on page 75
- Snap Bars to Output Resolution on page 79
- Box on page 82

7.2.22 ITF-14

About this Barcode...
ITF-14 is a standardized version of the Interleaved 2 of 5 barcode, containing 14 digits, the last being a check digit.
Parameters

General Parameters

• Rotation on page 70
• Code on page 70

Text Parameters

• Add Human Readable Characters on page 71
• Font Family, Style and Size on page 73
• Vertical Offset on page 73

Additional Parameters

• Text Format on page 74
• Bar Width Reduction on page 74
• Device Compensation on page 75
• Magnification on page 75
• Height on page 75
• Snap Bars to Output Resolution on page 79
• Total Height on page 81
• Smax / Smin on page 81
• Box on page 82

7.2.23 ITF-16

About this Barcode...

ITF-16 is a standardized version of the Interleaved 2 of 5 barcode, containing 16 digits, the last being a check digit.
Parameters

General Parameters

- Rotation on page 70
- Code on page 70

Text Parameters

- Add Human Readable Characters on page 71
- Font Family, Style and Size on page 73
- Vertical Offset on page 73

Additional Parameters

- Text Format on page 74
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Magnification on page 75
- Height on page 75
- Snap Bars to Output Resolution on page 79
- Total Height on page 81
- Smax / Smin on page 81
- Box on page 82

7.2.24 Interleaved 2 of 5

About this Barcode...

Interleaved 2 of 5 (or Int. 2 of 5) is a barcode originally used for transportation packaging, that can have any even number of digits. Since this type of packaging consists mainly of cardboard boxes printed in low quality, the Interleaved 2 of 5 barcode is more tolerant to distortion than other barcodes.
7.2.25 Laetus Pharma Code

About this Barcode...
This barcode was developed specifically to meet the requirements of the pharmaceutical packaging process. It has established itself as the worldwide pharmaceutical industry barcode standard. It can encode numeric or binary data.

Parameters
Laetus Pharma

General Parameters
• Rotation on page 70
• Code on page 70

Text Parameters
• Add Human Readable Characters on page 71
• Font Family, Style and Size on page 73
7.2.26 M+S 7

About this Barcode...
The M+S 7 barcode is an EAN 8 barcode modified by Marks & Spencer’s, for use on own-brand
products sold in their stores.
To make the M+S 7 barcode, the initial “0” is removed and the extra letters “M” and “S” are
added to the human readable characters.
This means that the human readable characters contain seven digits plus the “M” and “S”
letters.

Note: This doesn't affect the data encoded in the barcode (it still encodes eight digits), so you
should enter eight digits when creating a M+S 7 barcode.
Parameters

General Parameters
- Rotation on page 70
- Code on page 70

Text Parameters
- Add Human Readable Characters on page 71
- Font Family, Style and Size on page 73
- Vertical Offset on page 73

Additional Parameters
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Magnification on page 75
- Height on page 75
- Snap Bars to Output Resolution on page 79
- Box on page 82

7.2.27 MSI

About this Barcode...
MSI, also known as Modified Plessey, was developed by the MSI Data Corporation, based on the original Plessey Code. It is a numeric barcode used primarily to mark retail shelves for inventory control.
Dynamic Barcodes for Adobe Illustrator

- **Alignment** on page 73
- **Vertical Offset** on page 73

**Additional Parameters**
- **Bar Width Reduction** on page 74
- **Device Compensation** on page 75
- **Height** on page 75
- **Characters per unit** on page 76
- **Ratio** on page 78
- **Narrow Bar** on page 78
- **Snap Bars to Output Resolution** on page 79
- **Box** on page 82

### 7.2.28 Marks & Spencer's

**About this Barcode...**
The Marks & Spencer's barcode is also an EAN 8 barcode modified by Marks & Spencer's for use on own-brand products.

![Barcode Image]

**Parameters**

**General Parameters**
- **Rotation** on page 70
- **Code** on page 70

**Text Parameters**
- **Add Human Readable Characters** on page 71
- **Font Family, Style and Size** on page 73
- **Vertical Offset** on page 73

**Additional Parameters**
- **Bar Width Reduction** on page 74
7.2.29 NDC / HRI

About this Barcode...
The NDC / HRI barcode is a variant of the UPC barcode with special human readable interpretation formats compliant to the US National Drug Code definition.

Parameters

General Parameters
- *Rotation* on page 70
- *Code* on page 70

Text Parameters
- *Add Human Readable Characters* on page 71
- *Font Family, Style and Size* on page 73
- *Vertical Offset* on page 73

Additional Parameters
- *Text Format* on page 74
- *Bar Width Reduction* on page 74
- *Device Compensation* on page 75
- *Magnification* on page 75
- *Height* on page 75
7.2.30 Paraf Italy

About this Barcode...
This barcode is a variant of Code 39 used by the Italian Health and Cosmetics Industry. It is also called Code 32.

Use **Code Base32** when your barcode data is encoded in the Base 32 format. This format uses case-insensitive alphanumeric characters to encode data.

Use **Code Base10** when your barcode data is in decimal format. Paraf Italy barcodes in decimal format should start with an "A" (included automatically by Dynamic Barcodes), have 8 digits of data and end with a check digit (calculated automatically by Dynamic Barcodes).

Parameters

**General Parameters**
- **Rotation** on page 70
- **Code** on page 70

**Additional Parameters**
- **Bar Width Reduction** on page 74
- **Device Compensation** on page 75
- **Height** on page 75
- **Narrow Bar** on page 78
- **Snap Bars to Output Resolution** on page 79
- **Box** on page 82

7.2.31 PDF417

About this Barcode...
PDF417 is a 2D barcode mainly used in security printing (passports, identity cards, driving licences...).

It is a “self-checking” barcode that can have different levels of error correction.
It can encode data using one of three “compaction” modes: Text (to encode all alphanumeric and punctuation characters in the ISO-8859-1 character set), Numeric (to encode only numeric characters) or Binary (to encode 8-bit characters).

It can use the three compaction modes in a single barcode if necessary, but you can choose to disable the Text and/or Numeric compaction modes.

Parameters

General Parameters
- Rotation on page 70
- Code on page 70

Additional Parameters
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Height on page 75
- Narrow Bar on page 78
- Box on page 82

Specific Parameters

Columns
You can give your barcode between 1 and 30 Columns. The number of columns corresponds to the number of PDF417 codewords.

Rows
You can give your barcode between 3 and 90 Rows.

Truncated
Choose Truncated to make the symbol less wide by truncating the end character (which is not part of the encoded data) and the end pattern. In the example below, the top PDF417 barcode is not truncated, and the bottom barcode is truncated (but encodes the same data).

Initialize in Alpha Submode
Choose this option to generate a “shift to Text mode” character at the beginning of the barcode when using Text compaction mode. This makes the encoding clear for barcode scanners.
Dynamic Barcodes for Adobe Illustrator

**Allow Text Compaction**
Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your barcode contains text data.
This encodes the text data in your barcode more efficiently (it makes that part of your barcode smaller).

**Allow Numeric Compaction**
Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your barcode contains numeric data.
This encodes the numeric data in your barcode more efficiently.

**Note:**
Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary data.
If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic Barcodes will only use Binary compaction mode.

**Error Correction Level**
Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose an Error correction level from 0 to 8.
The higher the correction level, the more check sums are added to the barcode and the more incorrect data can be corrected. Keep in mind that a higher correction level makes the barcode bigger and may limit the maximum length of the encoded data.

**Note:** Level 0 means that there is only one check sum added to the data, so incorrect data can be detected but not corrected.

You can choose Automatic to let the plug-in pick the best error correction level for the data encoded.

### 7.2.32 MicroPDF417

**About this Barcode...**
MicroPDF417 is a 2D multi-row barcode derived from PDF417, for use on smaller areas. It can encode up to 150 bytes.

![MicroPDF417 barcode](image)

**Parameters**

**General Parameters**
- Rotation on page 70
- Code on page 70

**Additional Parameters**


Dynamic Barcodes for Adobe Illustrator

- **Bar Width Reduction** on page 74
- **Device Compensation** on page 75
- **Height** on page 75
- **Narrow Bar** on page 78
- **Snap Bars to Output Resolution** on page 79
- **Box** on page 82

**Specific Parameters**

**Columns**
You can give your barcode between 1 and 4 **Columns**.

**Rows**
You can give your barcode between 4 and 44 **Rows**.

**Allow Text Compaction**
Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your barcode contains text data.

This encodes the text data in your barcode more efficiently (it makes that part of your barcode smaller).

**Allow Numeric Compaction**
Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your barcode contains numeric data.

This encodes the numeric data in your barcode more efficiently.

**Note:**
Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary data.

If you don't enable either **Allow Text Compaction** or **Allow Numeric Compaction**, Dynamic Barcodes will only use Binary compaction mode.

### 7.2.33 PZN

**About this Barcode...**
The PZN (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnn” but only the numeric part including the leading dash is encoded.
Parameters

General Parameters

• Rotation on page 70
• Code on page 70

Text Parameters

• Add Human Readable Characters on page 71
• Font Family, Style and Size on page 73
• Alignment on page 73
• Vertical Offset on page 73

Additional Parameters

• Bar Width Reduction on page 74
• Device Compensation on page 75
• Size on page 75
• Height on page 75
• Characters per unit on page 76
• Ratio on page 78
• Narrow Bar on page 78
• Snap Bars to Output Resolution on page 79
• Box on page 82

7.2.34 PZN8

About this Barcode...
The PZN8 (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnnn” but only the numeric part including the leading dash is encoded.
Text Parameters

- Add Human Readable Characters on page 71
- Font Family, Style and Size on page 73
- Alignment on page 73
- Vertical Offset on page 73

Additional Parameters

- Bar Width Reduction on page 74
- Device Compensation on page 75
- Size on page 75
- Height on page 75
- Characters per unit on page 76
- Ratio on page 78
- Narrow Bar on page 78
- Snap Bars to Output Resolution on page 79
- Box on page 82

7.2.35 QR

About this Barcode...

The QR barcode is a 2-dimensional barcode used for commercial tracking and convenience-oriented applications aimed at mobile phone users (known as "mobile tagging").

QR codes storing addresses and URLs may appear in magazines, on signs, buses, business cards, or other objects... Users with a camera phone equipped with the correct reader application can scan the QR code to display text, contact information, connect to a wireless network, or open a web page in the phone's browser.

QR codes have the following structure:
• Position pattern (required)

• Alignment pattern (required)

• Timing pattern (required)

• Version information

• Format information

• Data and error correction keys

Parameters

General Parameters
• Rotation on page 70
• Code on page 70

Additional Parameters
• Bar Width Reduction on page 74
• Device Compensation on page 75
• Cell Size on page 80
• Width / Total Height on page 80
• Box on page 82

Specific Parameters

Minimum Symbol Size
Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note: If the number of cells you choose for your symbol is too small to encode the data you entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction
Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.
• Level M: 15% of codewords can be restored.
• Level Q: 25% of codewords can be restored.
• Level H: 30% of codewords can be restored.

**Note:** Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

<table>
<thead>
<tr>
<th>Width / Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol (Minimum Symbol Size).</td>
</tr>
<tr>
<td>For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.</td>
</tr>
</tbody>
</table>

### 7.2.36 MicroQR

**About this Barcode...**

The Micro QR Code is a very small QR Code for use on smaller spaces (for example to encode the ID of printed circuit boards and electronics parts).

It works with smaller amounts of data (maximum 35 numeric characters), and uses only one position pattern.

![MicroQR Code](image)

**Parameters**

**General Parameters**

• **Rotation** on page 70
• **Code** on page 70

**Additional Parameters**

• **Bar Width Reduction** on page 74
• **Device Compensation** on page 75
• **Cell Size** on page 80
• **Width / Total Height** on page 80
• **Box** on page 82

**Specific Parameters**

**Minimum Symbol Size**

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

**Note:** If the number of cells you choose for your symbol is too small to encode the data you entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.
**Error Correction**

Error correction adds check sums to the barcode to detect and correct incorrect data. You can choose one of the following Error correction levels:

- **Level L**: 7% of codewords can be restored.
- **Level M**: 15% of codewords can be restored.
- **Level Q**: 25% of codewords can be restored.
- **Level H**: 30% of codewords can be restored.

**Note:** Keep in mind that a higher correction level makes the barcode bigger (as more check sums are added to the barcode) and may limit the maximum length of the encoded data.

**Width / Height**

The **Width** and **Height** parameters depend on the **Cell Size** and the number of cells used for the symbol (**Minimum Symbol Size**).

For example, a symbol of 15 x 15 cells where each cell is 2 mm gives a Width and Height of 30 x 30 mm.

### 7.2.37 SICK Code

**About this Barcode...**

SICK is a bar code used in the German packaging industry. It's a binary bar code, using a thick bar for a 0, and a thin bar for a 1. It can have up to 12 bars. It can encode numeric or binary data.

- In binary mode all digits are encoded including leading zeroes, ie. "0001" is encoded as a three thin and one thick bar.
- In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number (6) defines the total number of bars, the second (4) defines the value to be encoded. If you don't define the number of bars, in other words if you enter a single number, the minimal number of bars needed for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value will change to "4/9", as you need at least 4 bars to encode this value.
- The defaults follow the mostly used standard "Codetype A", for generating the "Codetype B" should be changed the barcode parameters as following: Narrow Bar to 1.25mm (from 0.5mm), Wide Bar to 3.75mm (from 1.5mm) and Gap to 2.5mm (from 1mm)

By default, the values for the Narrow Bar (0.5mm), Wide Bar (1.5mm) and Gap (1mm) are set for the mostly used standard "Codetype A". If you want to generate a SICK code using "Codetype B", you should set the Narrow Bar to 1.25mm, the Wide Bar to 3.75mm and the Gap to 2.5mm

### Parameters

**General Parameters**
7.2.38 UPC-A

About this Barcode...

Universal Product Code or UPC is the standard for article numbering in the U.S.A. and Canada. It is similar to the EAN system and compatible with it. For more information on EAN, see EAN 13 on page 39.

UPC-A is a numeric barcode of up to twelve digits, plus two or five additional digits.
Parameters

General Parameters

• Rotation on page 70
• Code on page 70

Text Parameters

• Add Human Readable Characters on page 71
• Font Family, Style and Size on page 73
• Vertical Offset on page 73

Additional Parameters

• Bar Width Reduction on page 74
• Device Compensation on page 75
• Magnification on page 75
• Height on page 75
• Snap Bars to Output Resolution on page 79
• Box on page 82

7.2.39 UPC-E

About this Barcode...

UPC-E is an abbreviated version of UPC-A, for use on smaller packages. It is a numeric barcode of eight digits, with an optional 2 or 5 digits add-on. You can also directly enter the 12-digit code of UPC-A codes that can be represented in 8 digits.
Parameters

General Parameters
- Rotation on page 70
- Code on page 70

Text Parameters
- Add Human Readable Characters on page 71
- Font Family, Style and Size on page 73
- Vertical Offset on page 73

Additional Parameters
- Bar Width Reduction on page 74
- Device Compensation on page 75
- Magnification on page 75
- Height on page 75
- Snap Bars to Output Resolution on page 79
- Box on page 82

7.2.40 UPC-SCS

About this Barcode...
The UPC–SCS (Shipping Container Symbol) barcode is a version of the Interleaved 2 of 5 barcode that has a structure very similar to the Universal Product Code's (UPC) and specific formatting of the human readable interpretation.
7.3 Barcode Parameters

7.3.1 Rotation

To rotate your barcode by 90, 180 or 270 degrees, use the Rotation buttons.

To rotate it by any other angle, enter that angle in the Rotation field.

7.3.2 Code

Enter the data to encode in your bar code.

Dynamic Barcodes checks that the data you have entered is valid for your chosen Barcode Type. If it isn't, a warning / error will pop up.

**Code for GS1 Bar Codes**

When entering data to be encoded in GS1 bar codes, you can either enter Application Identifiers (AI) including the brackets, or you can enter the code without brackets, using FNC1 code at the end of each variable-length element in the data. While entering GS1 data, following remarks should be taken into account:

- Do not add the mandatory FNC1 character at the beginning of the data. Dynamic Barcodes will add it automatically.
- For GS1 bar codes intended for encoding AI (01) only, AI has to be omitted, i.e. don't enter ’01’ at the beginning. It doesn't matter if entered with or without brackets.
• The Composite Component can be created using the same rules for using brackets and [F1]. It’s not necessary to keep the same way of entering the Composite Component and the main code.
• If you don’t use brackets for entering AI, type [F1] at the end of each variable-length element in the data, to represent a FNC1 terminating character, except when the variable-length element is placed at the end of the whole code.
• You don’t need to type [F1] at the end of fixed-length elements.
• Do not mix using [F1] as terminators of variable AI and entering brackets around the AI.

Dynamic Barcodes also checks the validity of the Application Identifiers you enter in the Code and/or in the Composite Component of GS1 bar codes.

7.3.3 Composite Component

A Composite Component is a 2D symbol placed on top of a GS1 barcode, that encodes extra information (batch number, expiration date...).

If you want your barcode to have a Composite Component, enter the (alphanumeric) data to encode in this field.

Note: Dynamic Barcodes checks the data you enter for the Composite Component (for example to see if the Application Identifiers you entered are correct), and displays a warning if it is invalid.

7.3.4 Add Human Readable Characters

This parameter adds “human readable” characters (numeric or alphanumeric characters) under your barcode.

This is the same barcode with and without human readable characters:
7.3.5 Put on Top

This parameter allows you to put the Human Readable Characters above instead of below the barcode bars.

7.3.6 Multiple Text Lines

Select this parameter if you want the human readable characters to be printed on multiple lines below the barcode. Dynamic Barcodes will start a new line for every element of the barcode data (starting with the Application Identifier).

Note: When opening your document in PackEdge, the characters will be placed back on a single line.

7.3.7 Light Margin Indicator

This parameter adds “<” and “>” signs (or only “>” depending on the barcode type) at the bottom of your barcode. This indicates the width the barcode should have for optimal reading.
7.3.8 Font Family, Style and Size

These options can be used to define the font family, style and size to be used for the human readable characters. By choosing [default font], all other Text Parameters are disabled, as the default values are used.

**Note:** If the font used in a bar code is not available when opening the file, Adobe Illustrator will warn about a missing font. You can however only fix the problem using the Dynamic Barcode palette, since Adobe Illustrator’s “Find Font” feature can not be used.

7.3.9 Alignment

When using human readable characters, in combination with custom font settings, you can set text alignment to **Left**, **Center** or **Right**.

7.3.10 Vertical Offset

This parameter allows you to add extra space between your barcode bars and the human readable characters.
7.3.11 Use “992” Prod. Family in UPC

Enable this parameter to use the special “992” product family in your barcode (for specific offers like discounts on the customer’s next purchase or on variable weight items...).

7.3.12 Max. Row Width

Use this parameter to define how many segments of data (groups of bars encoding several digits) can fit in one row. If the barcode contains more segments, they will be stacked.

In the example below, the first barcode has a Max. Row Width of 8 segments. When reducing this to 4 segments, the segments that don't fit in the row width anymore are stacked, forming a second row (second barcode).

The GS1 Max Row Width parameter applies to the GS1 Databar Expanded Stacked component of the GS1 U.S. Coupon Interim barcode.

7.3.13 Text Format

Choose a text format for the human readable characters of your barcode.

For NDC/HRI barcodes, you can choose a variant of the U.S. National Drug Code.

For ITF-14, ITF-16 and UPC-SCS barcodes, you can choose a variant of the Shipping Container Symbol.

7.3.14 Bar Width Reduction

Use this to adjust the width of barcode bars, in order to compensate for ink bleeding when printing on your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer tells you that the line width will increase by 0.01mm, you should use a Bar Width Reduction value of 0.01 mm.

You can enter the Bar Width Reduction in microns, milliinches (“mil”), millimeters or inches.
7.3.15 Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar's width to compensate for bleed caused by the plate or film making process. You can enter the Device Compensation in microns, milliinches ("mil"), millimeters or inches.

**Note:** If you use both a Bar Width Reduction and a Device Compensation value, Dynamic Barcodes will add them to adjust the bar's width.

**Tip:** You can enter a negative value if you want to print thicker and not thinner bars.

7.3.16 Magnification

Use this parameter to increase or decrease the barcode size proportionally.

In the example below, you can see the same barcode at 80%, 100% and 120% magnification.

7.3.17 Size

Choose to give your PZN barcode a **Small**, **Normal** or **Large** size. Those are predefined sizes for this barcode. The actual Height, Characters per unit, Ratio and Narrow Bar values are shown underneath.

By selecting **Custom**, you can manually edit these four parameters.

7.3.18 Height

Enter the height to give to your barcode's bars. They need to be tall enough to be read easily by barcode scanners.

**Code 128**

In Dynamic Barcodes, you can create Code 128 barcodes shorter than the minimum height. Dynamic Barcodes will just display a warning, but if you export the document to EPF and open it in PackEdge, PackEdge will extend the barcode to its minimum required height.
Bars and Digits

For:

- EAN 8 & 13
- HIBC 128 and 39
- M+S 7, and Marks & Spencer's
- NDC / HRI
- UPC-A and UPC-E

For the bar codes listed above, the height you enter is the combined height of the bars and the human readable characters. Your barcode needs to be tall enough to be read easily by barcode scanners.

⚠️ Attention: Do not change the Height of the barcode before entering a Magnification value. The Height will change again according to the Magnification factor you define.

7.3.19 Characters per unit

This parameter allows you to define your barcode's width based on the encoding of (numeric or alphanumerical) characters.

You can choose the unit to use: micron, mil (milliinches), mm or inch.

For example, choose mm and use 1 Character per unit in the Dynamic Barcodes dialog if you want the bars needed to encode one character to take up 1 mm.
Increase the **Characters per unit** value to make the barcode narrower, or decrease it to make the barcode wider. For example, if you choose 0.5 **Character per unit**, the bars needed to encode one character will take up 2 mm.

**Note:** Barcodes like Interleaved 2 of 5 encode two characters together in a group of black and white bars. For these barcodes, Dynamic Barcodes takes half of the group of black and white bars to measure one character.
7.3.20 Ratio

The Ratio is the factor between the width of the narrow bar and the width of the wide bar in your barcode. For example, enter 3 if you want your wide bar to be three times as wide as your narrow bar.

7.3.21 Narrow Bar

This parameter determines the width of the narrowest bar of your barcode (and affects the width of your barcode proportionally). For GS1 barcodes, this affects the size (height and width) of your barcode proportionally.

7.3.22 Wide Bar

This parameter determines the width of the widest bar of your barcode.

7.3.23 Gap

Enter the width of the white space between the bars.

Note: The Ratio influences the Gap size: increasing the Ratio also increases the Gap size.

7.3.24 Vertical alignment

Dynamic Barcodes allows you to resize either the UPC-A or the GS1 Databar Expanded Stacked coupon barcode, so they are aligned vertically with each other. You can choose:

- None to keep the original size of both the UPC and the GS1 barcodes,

- Resize UPC to GS1 to resize the UPC barcode so it has the same height as the GS1 barcode,

- Resize GS1 to UPC to resize the GS1 barcode so it has the same height as the UPC barcode.
7.3.25 Snap Bars to Output Resolution

Use this to adjust the barcode size parameters (Bar Width Reduction, Device Compensation and Magnification) so that the bars' width and height take up a complete number of pixels or dots.

Enable Snap Bars to Output Resolution and enter the resolution you will use to print your barcode in ppi.

7.3.26 Decimal Input

Use this parameter to change the type of data you can enter in the Code field.

- Disable it to enter the data to encode in binary format.
- Enable it to enter the data in decimal instead of binary format.

**Note:** When using binary format for the Laetus Pharma Code/CLF-8 barcode data, you need to use a special "Pharma" binary format.

To convert a decimal number into a Pharma binary number, do the following:

1. Add 1 to your decimal number.
2. Convert the result to a binary number using a regular binary conversion algorithm.
3. Remove the first digit (which is 1).

You now have your Pharma binary input for the Laetus Pharma Code/CLF-8 barcode.

For example, you want to encode the number 3.

1. 3+1=4
2. 4 in binary is 100.
3. Without the first digit, it's 00.

Enter 00 in the Code field of your Laetus Pharma Code/CLF-8 barcode.

7.3.27 Add Check Digit

Use this parameter to add a check digit to your barcode data.
7.3.28 Symbol Type

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

**Note:** If the number of cells you choose for your symbol is too small to encode the data you entered in Code, Dynamic Barcodes will display an error.

You can choose Best Fit to make Dynamic Barcodes automatically adapt the number of cells to the amount of data you entered in Code.

7.3.29 Cell Size

Enter the size you want to give to each cell of the symbol. This affects the size of the whole symbol.

The unit used is the one you chose as Illustrator’s General unit in the Units & Display Performance Preferences.

In the example below, the first symbol has a 1 mm cell size (cells sides are 1 mm), and the second one a 2 mm cell size.

7.3.30 Width / Total Height

The Width and Total Height parameters depend on the Cell Size and the number of cells used for the symbol (Symbol Type).
In the example below, a symbol of 10 x 10 cells where each cell is 3 mm gives a Width and Total Height of 30 x 30 mm.

![Barcode Symbol](image)

**7.3.31 Total Height**

Enter the total height you want to give to your barcode. This is the combined height of the bars, the human readable characters and the box. If your barcode doesn't contain human readable characters or a box, the **Total Height** is the same as the bars' **Height**.

**7.3.32 Smax / Smin**

Use these parameters to define the width of the printability gauges (“H” marks) either side of your barcode. **Smax** defines the width of the left “H”, **Smin** defines the width of the right “H”. Enter 0 in both fields if you don't want printability gauges.

In the example below, the top barcode has a value of 0 for both **Smax** and **Smin**, the middle one has a value of 4 and the bottom one has a value of 8 (the maximum).
7.3.33 Box

Use this parameter to create an opaque white box under your barcode.

Use the **Top**, **Bottom**, **Left** and **Right** fields to add a white margin around your barcode and make the box bigger.
By default, Dynamic Barcodes links the four margins’ values so that when you change one of them, the other ones are updated automatically.

If you want to change them independently, click the link symbol to make it look detached.

For ITF, UCP and UPC-SCS bar codes, the box will be transparent, with bearer bars around it. The **Box Line Width** parameter defines the width of the bearer bars.

The option **Only Top and Bottom Bars** limits the bearer bars to only the top and bottom line.
## 8. Barcode Parameters from the Job Folder

Automation Engine stores information related to the printing jobs within the Job Folder. Each Job Folder can hold various job-related technical information, including barcode parameters.

The following barcode parameters can be set in Automation Engine Pilot:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Note</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>The type of barcode. You can’t have two different bar codes of the same type in one job.</td>
<td><strong>Symbol Type</strong> on page 80</td>
</tr>
<tr>
<td><strong>Sub Type</strong></td>
<td>The size of the symbol for Datamatrix barcodes.</td>
<td><strong>Code</strong> on page 70</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>The encoded value including check digits.</td>
<td></td>
</tr>
<tr>
<td><strong>Composite Code</strong></td>
<td>For barcodes with a Composite Component - mainly GS1 Databar codes</td>
<td><strong>Composite Component</strong> on page 71</td>
</tr>
<tr>
<td><strong>Output Resolution</strong></td>
<td>Snap Bars to Output Resolution on page 79</td>
<td></td>
</tr>
<tr>
<td><strong>Bar Width Reduction</strong></td>
<td>Bar Width Reduction on page 74</td>
<td></td>
</tr>
<tr>
<td><strong>Device Compensation</strong></td>
<td>Device Compensation on page 75</td>
<td></td>
</tr>
<tr>
<td><strong>Narrow Bar</strong></td>
<td>Main size parameter for Code128, Int2of5 and GS1 Databar barcodes</td>
<td><strong>Narrow Bar</strong> on page 78</td>
</tr>
<tr>
<td><strong>Magnification</strong></td>
<td>Main proportional size parameter for EAN and UPC based barcodes</td>
<td><strong>Magnification</strong> on page 75</td>
</tr>
<tr>
<td><strong>Ratio</strong></td>
<td>Used for Int2of5 barcodes</td>
<td><strong>Ratio</strong> on page 78</td>
</tr>
</tbody>
</table>

**Important:** Automation Engine does not check the parameters. All listed parameters are available for all barcode types, even if they are not valid for the given barcode type. Make sure you’re entering the valid inputs, including a correct Code with its check digit.

**Note:** It is not necessary to have the parameters already set on the Job Setup when creating barcodes: as soon as the Job Setup contains the settings for connected barcodes, these barcode parameters will be applied. This allows you to create templates or placeholders before the actual data (code for the barcode, etc) is available.

### 8.1 Connecting to a Job Folder

In order to take parameters from an Automation Engine Job Folder, you need to be connected to an Automation Engine, and open the file from the Automation Engine Job Folder. For easy locating the file on the server, you can use **File > Job Folder > Open from Job folder**.
For more information on how to connect to Automation Engine, and on opening from a Job Folder, we refer to the Esko DataExchange documentation. See http://help.esko.com/products/Esko%20Data%20Exchange%20for%20Adobe%20Illustrator

8.2 Connect Dynamic Barcodes to Job Setup

To use the Barcode properties from the Job Folder, enable the **Get Properties from Job Setup**. When enabled, the icon on the right will indicate the status:

- Gray: the feature is disabled
- Green: the connection is established
- Red: the file is not in a Job Folder, or the connection is down.

8.3 Use Barcode parameters from Job Setup

To use the barcode parameters from Job Setup, select a barcode type from the Barcode Type list that is defined in the Job setup. You can recognize these barcode types by the green icon in front.
As soon as you select one of the barcode types defined in the Job Setup, all parameters that are defined in the job setup will be entered (and no longer be editable), indicated by the same green icon.

In the example above, only the **Code** is defined in the Job Setup. All other parameters can be entered freely.
8.4 Updating barcode parameters from Job Setup

If a barcode is connected to the Job Setup, any changes to the barcode parameters in the Job Setup, whether it is a changed parameter or a newly added parameter, will automatically and immediately be taken into account in Dynamic Barcodes.

When opening a file, all barcodes with the Get Properties from Job Setup option enabled will be updated automatically.

If a barcode type is removed from the Job Setup, the corresponding barcodes in the job will no longer be connected, so the Get Properties from Job Setup option is disabled.

A barcode will also be disconnected and the Get Properties from Job Setup option will be disabled in case the barcode parameters in the Job Setup are invalid for the given barcode type. You will need to change the parameters in the Job Setup. Note that after correcting the parameters, you need to manually reconnect the barcode by enabling Get Properties from Job Setup.